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Stat 328 

Part-1 

Statistical Analysis using Excel 

There are many statistical analysis 
methods can be achieved using Excel 

1-1 Functions 
Three different type of function can be 
used in statistics; they are: 

 
(a) Statistical Functions 
(b) Mathematical Functions 
(c) Logical Functions 
 
These function can be obtained from 
excel as: 
 
 
Click the Formulas tab, then select the Insert Function command 
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Then, we get  
 

 
 
 



3 
 

So, if we select the statistical to get a 
list of possible statistical functions as 
follows: 
 

Count & Frequency 

COUNT Returns the number of numerical values in a supplied set of cells or values 

COUNTA Returns the number of non-blanks in a supplied set of cells or values 

COUNTBLANK Returns the number of blank cells in a supplied range 

COUNTIF Returns the number of cells (of a supplied range), that satisfy a given criteria 

COUNTIFS Returns the number of cells (of a supplied range), that satisfy a set of given 
criteria (New in Excel 2007) 

FREQUENCY Returns an array showing the number of values from a supplied array, which 
fall into specified ranges 

 

Finding the Largest & Smallest Values 

MAX Returns the largest value from a list of supplied numbers 

MAXA Returns the largest value from a list of supplied values, counting text and 
the logical value FALSE as the value 0 and counting the logical value TRUE 
as the value 1 

MAXIFS Returns the largest value from a subset of values in a list that are specified 
according to one or more criteria. (New in Excel 2016) 

MIN Returns the smallest value from a list of supplied numbers 

MINA Returns the smallest value from a list of supplied values, counting text and 
the logical value FALSE as the value 0 and counting the logical value TRUE 
as the value 1 

MINIFS Returns the smallest value from a subset of values in a list that are 
specified according to one or more criteria. (New in Excel 2016) 

LARGE Returns the Kth LARGEST value from a list of supplied numbers, for a given 
value K 

SMALL Returns the Kth SMALLEST value from a list of supplied numbers, for a 
given value K 

 

Percentiles, Quartiles & Rank 

http://www.excelfunctions.net/Excel-Count-Function.html
http://www.excelfunctions.net/Excel-Counta-Function.html
http://www.excelfunctions.net/Excel-Countblank-Function.html
http://www.excelfunctions.net/ExcelCountif.html
http://www.excelfunctions.net/Excel-Countifs-Function.html
http://www.excelfunctions.net/Excel-Frequency-Function.html
http://www.excelfunctions.net/MaxFunction.html
http://www.excelfunctions.net/Excel-Maxa-Function.html
http://www.excelfunctions.net/excel-maxifs-function.html
http://www.excelfunctions.net/MinFunction.html
http://www.excelfunctions.net/Excel-Mina-Function.html
http://www.excelfunctions.net/excel-minifs-function.html
http://www.excelfunctions.net/LargeFunction.html
http://www.excelfunctions.net/SmallFunction.html
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PERCENTILE Returns the K'th percentile of values in a supplied range, where K is in the 
range 0 - 1 (inclusive) (Replaced by Percentile.Inc function in Excel 2010) 

PERCENTILE.INC Returns the K'th percentile of values in a supplied range, where K is in the 
range 0 - 1 (inclusive) (New in Excel 2010 - replaces the Percentile function) 

PERCENTILE.EXC Returns the K'th percentile of values in a supplied range, where K is in the 
range 0 - 1 (exclusive) (New in Excel 2010) 

QUARTILE Returns the specified quartile of a set of supplied numbers, based on 
percentile value 0 - 1 (inclusive) (Replaced by Quartile.Inc function in Excel 
2010) 

QUARTILE.INC Returns the specified quartile of a set of supplied numbers, based on 
percentile value 0 - 1 (inclusive) (New in Excel 2010 - replaces the Quartile 
function) 

QUARTILE.EXC Returns the specified quartile of a set of supplied numbers, based on 
percentile value 0 - 1 (exclusive) (New in Excel 2010) 

RANK 
 

Returns the statistical rank of a given value, within a supplied array of 
values (Replaced by Rank.Eq function in Excel 2010) 

RANK.EQ Returns the Mode (the most frequently occurring value) of a list of 
supplied numbers (if more than one value has same rank, the top rank of 
that set is returned) (New in Excel 2010 - replaces the Rank function) 

RANK.AVG Returns the statistical rank of a given value, within a supplied array of 
values (if more than one value has same rank, the average rank is 
returned) (New in Excel 2010) 

PERCENTRANK Returns the rank of a value in a data set, as a percentage (0 - 1 
inclusive) (Replaced by Percentrank.Inc function in Excel 2010) 

PERCENTRANK.INC Returns the rank of a value in a data set, as a percentage (0 - 1 
inclusive) (New in Excel 2010 - replaces the Percentrank function) 

PERCENTRANK.EXC Returns the rank of a value in a data set, as a percentage (0 - 1 
exclusive) (New in Excel 2010) 

 

Averages 

AVERAGE Returns the Average of a list of supplied numbers 

AVERAGEA Returns the Average of a list of supplied numbers, counting text and the 
logical value FALSE as the value 0 and counting the logical value TRUE as 
the value 1 

AVERAGEIF Calculates the Average of the cells in a supplied range, that satisfy a given 
criteria (New in Excel 2007) 

AVERAGEIFS Calculates the Average of the cells in a supplied range, that satisfy multiple 
criteria (New in Excel 2007) 

http://www.excelfunctions.net/Excel-Percentile-Function.html
http://www.excelfunctions.net/Excel-Percentile-Inc-Function.html
http://www.excelfunctions.net/Excel-Percentile-Exc-Function.html
http://www.excelfunctions.net/Excel-Quartile-Function.html
http://www.excelfunctions.net/Excel-Quartile-Inc-Function.html
http://www.excelfunctions.net/Excel-Quartile-Exc-Function.html
http://www.excelfunctions.net/Excel-Rank-Function.html
http://www.excelfunctions.net/Excel-Rank-Eq-Function.html
http://www.excelfunctions.net/Excel-Rank-Avg-Function.html
http://www.excelfunctions.net/Excel-Percentrank-Function.html
http://www.excelfunctions.net/Excel-Percentrank-Inc-Function.html
http://www.excelfunctions.net/Excel-Percentrank-Exc-Function.html
http://www.excelfunctions.net/ExcelAverage.html
http://www.excelfunctions.net/Excel-Averagea-Function.html
http://www.excelfunctions.net/Excel-Averageif-Function.html
http://www.excelfunctions.net/Excel-Averageifs-Function.html
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MEDIAN Returns the Median (the middle value) of a list of supplied numbers 

MODE Returns the Mode (the most frequently occurring value) of a list of 
supplied numbers (Replaced by Mode.Sngl function in Excel 2010) 

MODE.SNGL Returns the Mode (the most frequently occurring value) of a list of 
supplied numbers (New in Excel 2010 - replaces the Mode function) 

MODE.MULT Returns a vertical array of the most frequently occurring values in an array 
or range of data (New in Excel 2010) 

GEOMEAN Returns the geometric mean of a set of supplied numbers 

HARMEAN Returns the harmonic mean of a set of supplied numbers 

TRIMMEAN Returns the mean of the interior of a supplied set of values 

 

Deviation & Variance 

AVEDEV Returns the average of the absolute deviations of data points from their 
mean 

DEVSQ Returns the sum of the squares of the deviations of a set of data points 
from their sample mean 

STDEV Returns the standard deviation of a supplied set of values (which 
represent a sample of a population) (Replaced by Stdev.S function in Excel 
2010) 

STDEV.S Returns the standard deviation of a supplied set of values (which 
represent a sample of a population) (New in Excel 2010 - replaces the 
Stdev function) 

STDEVA Returns the standard deviation of a supplied set of values (which 
represent a sample of a population), counting text and the logical value 
FALSE as the value 0 and counting the logical value TRUE as the value 1 

STDEVP Returns the standard deviation of a supplied set of values (which 
represent an entire population) (Replaced by Stdev.P function in Excel 
2010) 

STDEV.P Returns the standard deviation of a supplied set of values (which 
represent an entire population) (New in Excel 2010 - replaces the Stdevp 
function) 

STDEVPA Returns the standard deviation of a supplied set of values (which 
represent an entire population), counting text and the logical value FALSE 
as the value 0 and counting the logical value TRUE as the value 1 

VAR Returns the variance of a supplied set of values (which represent a sample 
of a population) (Replaced by Var.S function in Excel 2010) 

http://www.excelfunctions.net/Excel-Median-Function.html
http://www.excelfunctions.net/Excel-Mode-Function.html
http://www.excelfunctions.net/Excel-Mode-Sngl-Function.html
http://www.excelfunctions.net/Excel-Mode-Mult-Function.html
http://www.excelfunctions.net/Excel-Geomean-Function.html
http://www.excelfunctions.net/Excel-Harmean-Function.html
http://www.excelfunctions.net/Excel-Trimmean-Function.html
http://www.excelfunctions.net/Excel-Avedev-Function.html
http://www.excelfunctions.net/Excel-Devsq-Function.html
http://www.excelfunctions.net/Excel-Stdev-Function.html
http://www.excelfunctions.net/Excel-Stdev-S-Function.html
http://www.excelfunctions.net/Excel-Stdeva-Function.html
http://www.excelfunctions.net/Excel-Stdevp-Function.html
http://www.excelfunctions.net/Excel-Stdev-P-Function.html
http://www.excelfunctions.net/Excel-Stdevpa-Function.html
http://www.excelfunctions.net/Excel-Var-Function.html
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VAR.S Returns the variance of a supplied set of values (which represent a sample 
of a population) (New in Excel 2010 - replaces the Var function) 

VARA Returns the variance of a supplied set of values (which represent a sample 
of a population), counting text and the logical value FALSE as the value 0 
and counting the logical value TRUE as the value 1 

VARP Returns the variance of a supplied set of values (which represent an entire 
population) (Replaced by Var.P function in Excel 2010) 

VAR.P Returns the variance of a supplied set of values (which represent an entire 
population) (New in Excel 2010 - replaces the Varp function) 

VARPA Returns the variance of a supplied set of values (which represent an entire 
population), counting text and the logical value FALSE as the value 0 and 
counting the logical value TRUE as the value 1 

COVAR Returns population covariance (i.e. the average of the products of 
deviations for each pair within two supplied data sets) (Replaced by 
Covariance.P function in Excel 2010) 

COVARIANCE.P Returns population covariance (i.e. the average of the products of 
deviations for each pair within two supplied data sets) (New in Excel 2010 - 
replaces the Covar function) 

COVARIANCE.S Returns sample covariance (i.e. the average of the products of deviations 
for each pair within two supplied data sets) (New in Excel 2010) 

 

Confidence Intervals 

CONFIDENCE Returns the confidence interval for a population mean, using a normal 
distribution (Replaced by Confidence.Norm function in Excel 2010) 

CONFIDENCE.NORM Returns the confidence interval for a population mean, using a normal 
distribution (New in Excel 2010 - replaces the Confidence function) 

CONFIDENCE.T Returns the confidence interval for a population mean, using a Student's t 
distribution (New in Excel 2010) 

 

Trend Line Functions 

FORECAST Predicts a future point on a linear trend line fitted to a supplied set of x- 
and y- values 

INTERCEPT Calculates the best fit regression line, through a supplied series of x- and y- 
values and returns the value at which this line intercepts the y-axis 

LINEST Returns statistical information describing the trend of the line of best fit, 
through a supplied series of x- and y- values 
 
 

http://www.excelfunctions.net/Excel-Var-S-Function.html
http://www.excelfunctions.net/Excel-Vara-Function.html
http://www.excelfunctions.net/Excel-Varp-Function.html
http://www.excelfunctions.net/Excel-Var-P-Function.html
http://www.excelfunctions.net/Excel-Varpa-Function.html
http://www.excelfunctions.net/Excel-Covar-Function.html
http://www.excelfunctions.net/Excel-Covariance-P-Function.html
http://www.excelfunctions.net/Excel-Covariance-S-Function.html
http://www.excelfunctions.net/Excel-Confidence-Function.html
http://www.excelfunctions.net/Excel-Confidence-Norm-Function.html
http://www.excelfunctions.net/Excel-Confidence-T-Function.html
http://www.excelfunctions.net/Excel-Forecast-Function.html
http://www.excelfunctions.net/Excel-Intercept-Function.html
http://www.excelfunctions.net/Excel-Linest-Function.html
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SLOPE Returns the slope of the linear regression line through a supplied series of 
x- and y- values 

TREND Calculates the trend line through a given set of y-values and returns 
additional y-values for a supplied set of new x-values 

GROWTH Returns numbers in a exponential growth trend, based on a set of supplied 
x- and y- values 

LOGEST Returns the parameters of an exponential trend for a supplied set of x- 
and y- values 

STEYX Returns the standard error of the predicted y-value for each x in the 
regression line for a set of supplied x- and y- values 

 

PERMUT Returns the number of permutations 
for a given number of objects 

PERMUTATIONA Returns the number of permutations 
for a given number of objects (with 
repetitions) that can be selected from 
the total objects (New in Excel 2013) 

 

Distribution & Tests of Probability 

BETADIST Returns the cumulative beta probability density 
function (Replaced by Beta.Dist function in Excel 2010) 

BETA.DIST Returns the cumulative beta distribution function or the beta 
probability density function (New in Excel 2010 - replaces the 
Betadist function) 

BETAINV Returns the inverse of the cumulative beta probability density 
function (Replaced by Beta.Inv function in Excel 2010) 

BETA.INV Returns the inverse of the cumulative beta probability density 
function (New in Excel 2010 - replaces the Betainv function) 

BINOMDIST Returns the individual term binomial distribution 
probability (Replaced by Binom.Dist function in Excel 2010) 

BINOM.DIST Returns the individual term binomial distribution 
probability (New in Excel 2010 - replaces the Binomdist 
function) 

http://www.excelfunctions.net/Excel-Slope-Function.html
http://www.excelfunctions.net/Excel-Trend-Function.html
http://www.excelfunctions.net/Excel-Growth-Function.html
http://www.excelfunctions.net/Excel-Logest-Function.html
http://www.excelfunctions.net/Excel-Steyx-Function.html
http://www.excelfunctions.net/Excel-Permut-Function.html
http://www.excelfunctions.net/excel-permutationa-function.html
http://www.excelfunctions.net/Excel-Betadist-Function.html
http://www.excelfunctions.net/Excel-Beta-Dist-Function.html
http://www.excelfunctions.net/Excel-Betainv-Function.html
http://www.excelfunctions.net/Excel-Beta-Inv-Function.html
http://www.excelfunctions.net/Excel-Binomdist-Function.html
http://www.excelfunctions.net/Excel-Binom-Dist-Function.html
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BINOM.DIST.RANGE Returns the probability of a trial result using a binomial 
distribution (New in Excel 2013) 

NEGBINOMDIST Returns the negative binomial distribution (Replaced by 
Negbinom.Dist function in Excel 2010) 

NEGBINOM.DIST Returns the negative binomial distribution (New in Excel 2010 - 
replaces the Negbinomdist function) 

CRITBINOM Returns the smallest value for which the cumulative binomial 
distribution is greater than or equal to a criterion 
value (Replaced by Binom.Inv function in Excel 2010) 

BINOM.INV Returns the smallest value for which the cumulative binomial 
distribution is greater than or equal to a criterion value (New in 
Excel 2010 - replaces the Critbinom function) 

CHIDIST Returns the right-tailed probability of the chi-squared 
distribution (Replaced by Chisq.Dist.Rt function in Excel 2010) 

CHISQ.DIST.RT Returns the right-tailed probability of the chi-squared 
distribution (New in Excel 2010 - replaces the Chidist function) 

CHISQ.DIST Returns the chi-squared distribution (probability density or 
cumulative distribution function) (New in Excel 2010) 

CHIINV Returns the inverse of the right-tailed probability of the chi-
squared distribution (Replaced by Chisq.Inv.Rt function in Excel 
2010) 

CHISQ.INV.RT Returns the inverse of the right-tailed probability of the chi-
squared distribution (New in Excel 2010 - replaces the Chiinv 
function) 

CHISQ.INV Returns the inverse of the left-tailed probability of the chi-
squared distribution (New in Excel 2010) 

CHITEST Returns the chi-squared statistical test for 
independence (Replaced by Chisq.Test function in Excel 2010) 

CHISQ.TEST Returns the chi-squared statistical test for independence (New 
in Excel 2010 - replaces the Chitest function) 

CORREL Returns the correlation coefficient between two sets of values 

EXPONDIST Returns the exponential distribution (Replaced by Expon.Dist 
function in Excel 2010) 

EXPON.DIST Returns the exponential distribution (New in Excel 2010 - 
replaces the Expondist function) 

FDIST Returns the right-tailed F probability distribution for two data 
sets (Replaced by F.Dist.Rt function in Excel 2010) 

http://www.excelfunctions.net/excel-binom-dist-range-function.html
http://www.excelfunctions.net/Excel-Negbinomdist-Function.html
http://www.excelfunctions.net/Excel-Negbinom-Dist-Function.html
http://www.excelfunctions.net/Excel-Critbinom-Function.html
http://www.excelfunctions.net/Excel-Binom-Inv-Function.html
http://www.excelfunctions.net/Excel-Chidist-Function.html
http://www.excelfunctions.net/Excel-Chisq-Dist-Rt-Function.html
http://www.excelfunctions.net/Excel-Chisq-Dist-Function.html
http://www.excelfunctions.net/Excel-Chiinv-Function.html
http://www.excelfunctions.net/Excel-Chisq-Inv-Rt-Function.html
http://www.excelfunctions.net/Excel-Chisq-Inv-Function.html
http://www.excelfunctions.net/Excel-Chitest-Function.html
http://www.excelfunctions.net/Excel-Chisq-Test-Function.html
http://www.excelfunctions.net/Excel-Correl-Function.html
http://www.excelfunctions.net/Excel-Expondist-Function.html
http://www.excelfunctions.net/Excel-Expon-Dist-Function.html
http://www.excelfunctions.net/Excel-Fdist-Function.html
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F.DIST.RT Returns the right-tailed F probability distribution for two data 
sets (New in Excel 2010 - replaces the Fdist function) 

F.DIST Returns the F probability distribution (probability density or 
cumulative distribution function) (New in Excel 2010) 

FINV Returns the inverse of the right-tailed F probability distribution 
for two data sets (Replaced by F.Inv.Rt function in Excel 2010) 

F.INV.RT Returns the inverse of the right-tailed F probability distribution 
for two data sets (New in Excel 2010 - replaces the Finv 
function) 

F.INV Returns the inverse of the Cumulative F distribution (New in 
Excel 2010) 

FISHER Returns the Fisher transformation 

FISHERINV Returns the inverse of the Fisher transformation 

FTEST Returns the result of an F-Test for 2 supplied data 
sets (Replaced by F.Test function in Excel 2010) 

F.TEST Returns the result of an F-Test for 2 supplied data sets (New in 
Excel 2010 - replaces the Ftest function) 

GAMMADIST Returns the gamma distribution (Replaced by Gamma.Dist 
function in Excel 2010) 

GAMMA.DIST Returns the gamma distribution (New in Excel 2010 - replaces 
the Gammadist function) 

GAMMAINV Returns the inverse gamma cumulative distribution (Replaced 
by Gamma.Inv function in Excel 2010) 

GAMMA.INV Returns the inverse gamma cumulative distribution (New in 
Excel 2010 - replaces the Gammainv function) 

GAMMA Return the gamma function value for a supplied number (New 
in Excel 2013) 

GAMMALN Calculates the natural logarithm of the gamma function for a 
supplied value 

GAMMALN.PRECISE Returns the natural logarithm of the gamma function for a 
supplied value (New in Excel 2010) 

GAUSS Calculates the probability that a member of a standard normal 
population will fall between the mean and z standard 
deviations from the mean (New in Excel 2013) 

HYPGEOMDIST Returns the hypergeometric distribution (Replaced by 
Hypgeom.Dist function in Excel 2010) 

HYPGEOM.DIST Returns the hypergeometric distribution (New in Excel 2010 - 
replaces the Hypgeomdist function) 

http://www.excelfunctions.net/Excel-F-Dist-Rt-Function.html
http://www.excelfunctions.net/Excel-F-Dist-Function.html
http://www.excelfunctions.net/Excel-Finv-Function.html
http://www.excelfunctions.net/Excel-F-Inv-Rt-Function.html
http://www.excelfunctions.net/Excel-F-Inv-Function.html
http://www.excelfunctions.net/Excel-Fisher-Function.html
http://www.excelfunctions.net/Excel-Fisherinv-Function.html
http://www.excelfunctions.net/Excel-Ftest-Function.html
http://www.excelfunctions.net/Excel-F-Test-Function.html
http://www.excelfunctions.net/Excel-Gammadist-Function.html
http://www.excelfunctions.net/Excel-Gamma-Dist-Function.html
http://www.excelfunctions.net/Excel-Gammainv-Function.html
http://www.excelfunctions.net/Excel-Gamma-Inv-Function.html
http://www.excelfunctions.net/excel-gamma-function.html
http://www.excelfunctions.net/Excel-Gammaln-Function.html
http://www.excelfunctions.net/Excel-Gammaln-Precise-Function.html
http://www.excelfunctions.net/excel-gauss-function.html
http://www.excelfunctions.net/Excel-Hypgeomdist-Function.html
http://www.excelfunctions.net/Excel-Hypgeom-Dist-Function.html
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KURT Returns the kurtosis of a data set 

LOGNORMDIST Returns the cumulative log-normal distribution (Replaced by 
Lognorm.Dist function in Excel 2010) 

LOGNORM.DIST Returns the log-normal probability density function or the 
cumulative log- normal distribution (New in Excel 2010 - 
replaces the Lognormdist function) 

LOGINV Returns the inverse of the lognormal distribution (Replaced by 
Lognorm.Inv function in Excel 2010) 

LOGNORM.INV Returns the inverse of the lognormal distribution (New in Excel 
2010 - replaces the Loginv function) 

NORMDIST Returns the normal cumulative distribution (Replaced by 
Norm.Dist function in Excel 2010) 

NORM.DIST Returns the normal cumulative distribution (New in Excel 2010 
- replaces the Normdist function) 

NORMINV Returns the inverse of the normal cumulative 
distribution (Replaced by Norm.Inv function in Excel 2010) 

NORM.INV Returns the inverse of the normal cumulative distribution (New 
in Excel 2010 - replaces the Norminv function) 

NORMSDIST Returns the standard normal cumulative distribution (Replaced 
by Norm.S.Dist function in Excel 2010) 

NORM.S.DIST Returns the standard normal cumulative distribution (New in 
Excel 2010 - replaces the Normsdist function) 

NORMSINV Returns the inverse of the standard normal cumulative 
distribution (Replaced by Norm.S.Inv function in Excel 2010) 

NORM.S.INV Returns the inverse of the standard normal cumulative 
distribution (New in Excel 2010 - replaces the Normsinv 
function) 

PEARSON Returns the Pearson product moment correlation coefficient 

RSQ Returns the square of the Pearson product moment correlation 
coefficient 

PHI Returns the value of the density function for a standard normal 
distribution, for a supplied number (New in Excel 2013) 

POISSON Returns the Poisson distribution (Replaced by Poisson.Dist 
function in Excel 2010) 

POISSON.DIST Returns the Poisson distribution (New in Excel 2010 - replaces 
the Poisson function) 

PROB Returns the probablity that values in a supplied range are 
within given limits 

http://www.excelfunctions.net/Excel-Kurt-Function.html
http://www.excelfunctions.net/Excel-Lognormdist-Function.html
http://www.excelfunctions.net/Excel-Lognorm-Dist-Function.html
http://www.excelfunctions.net/Excel-Loginv-Function.html
http://www.excelfunctions.net/Excel-Lognorm-Inv-Function.html
http://www.excelfunctions.net/Excel-Normdist-Function.html
http://www.excelfunctions.net/Excel-Norm-Dist-Function.html
http://www.excelfunctions.net/Excel-Norminv-Function.html
http://www.excelfunctions.net/Excel-Norm-Inv-Function.html
http://www.excelfunctions.net/Excel-Normsdist-Function.html
http://www.excelfunctions.net/Excel-Norm-S-Dist-Function.html
http://www.excelfunctions.net/Excel-Normsinv-Function.html
http://www.excelfunctions.net/Excel-Norm-S-Inv-Function.html
http://www.excelfunctions.net/Excel-Pearson-Function.html
http://www.excelfunctions.net/Excel-Rsq-Function.html
http://www.excelfunctions.net/excel-phi-function.html
http://www.excelfunctions.net/Excel-Poisson-Function.html
http://www.excelfunctions.net/Excel-Poisson-Dist-Function.html
http://www.excelfunctions.net/Excel-Prob-Function.html
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SKEW Returns the skewness of a distribution 

SKEW.P Returns the skewness of a distribution based on a 
population (New in Excel 2013) 

STANDARDIZE Returns a normalized value 

TDIST Returns the Student's T-distribution (Replaced by T.Dist.2t & 
T.Dist.Rt functions in Excel 2010) 

T.DIST.2T Returns the two-tailed Student's T-distribution (New in Excel 
2010 - replaces the Tdist function) 

T.DIST.RT Returns the right-tailed Student's T-distribution (New in Excel 
2010 - replaces the Tdist function) 

T.DIST Returns the Student's T-distribution (probability density or 
cumulative distribution function) (New in Excel 2010) 

TINV Returns the two-tailed inverse of the Student's T-
distribution (Replaced by T.Inv.2t function in Excel 2010) 

T.INV.2T Returns the two-tailed inverse of the Student's T-
distribution (New in Excel 2010 - replaces the Tinv function) 

T.INV Returns the left-tailed inverse of the Student's T-
distribution (New in Excel 2010) 

TTEST Returns the probability associated with a Student's T-
Test (Replaced by T.Test function in Excel 2010) 

T.TEST Returns the probability associated with a Student's T-Test (New 
in Excel 2010 - replaces the Ttest function) 

WEIBULL Returns the Weibull distribution (Replaced by Weibull.Dist 
function in Excel 2010) 

WEIBULL.DIST Returns the Weibull distribution (New in Excel 2010 - replaces 
the Weibull function) 

ZTEST Returns the one-tailed probability value of a z-test (Replaced 
by Z.Test function in Excel 2010) 

Z.TEST Returns the one-tailed probability value of a z-test (New in 
Excel 2010 - replaces the Ztest function) 

 
 
 

http://www.excelfunctions.net/Excel-Skew-Function.html
http://www.excelfunctions.net/excel-skew-p-function.html
http://www.excelfunctions.net/Excel-Standardize-Function.html
http://www.excelfunctions.net/Excel-Tdist-Function.html
http://www.excelfunctions.net/Excel-T-Dist-2t-Function.html
http://www.excelfunctions.net/Excel-T-Dist-Rt-Function.html
http://www.excelfunctions.net/Excel-T-Dist-Function.html
http://www.excelfunctions.net/Excel-Tinv-Function.html
http://www.excelfunctions.net/Excel-T-Inv-2t-Function.html
http://www.excelfunctions.net/Excel-T-Inv-Function.html
http://www.excelfunctions.net/Excel-Ttest-Function.html
http://www.excelfunctions.net/Excel-T-Test-Function.html
http://www.excelfunctions.net/Excel-Weibull-Function.html
http://www.excelfunctions.net/Excel-Weibull-Dist-Function.html
http://www.excelfunctions.net/Excel-Ztest-Function.html
http://www.excelfunctions.net/Excel-Z-Test-Function.html
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Similarly, if we select the Math& Trig 
We get a list of possible Mathematical 
functions as follows: 
 

Basic Numeric Information 

ABS Returns the absolute value (i.e. the modulus) of a supplied number 

SIGN Returns the sign (+1, -1 or 0) of a supplied number 

GCD Returns the Greatest Common Divisor of two or more supplied numbers 

LCM Returns the Least Common Multiple of two or more supplied numbers 

 

Basic Mathematical Operations 

SUM Returns the sum of a supplied list of numbers 

PRODUCT Returns the product of a supplied list of numbers 

POWER Returns the result of a given number raised to a supplied power 

SQRT Returns the positive square root of a given number 

QUOTIENT Returns the integer portion of a division between two supplied numbers 

MOD Returns the remainder from a division between two supplied numbers 

AGGREGATE Performs a specified calculation (e.g. the sum, product, average, etc.) for a list or 
database, with the option to ignore hidden rows and error values (New in Excel 
2010) 

SUBTOTAL Performs a specified calculation (e.g. the sum, product, average, etc.) for a 
supplied set of values 

 

Rounding Functions 

CEILING Rounds a number away from zero (i.e. rounds a positive number up and a 
negative number down), to a multiple of significance 

CEILING.PRECISE Rounds a number up, regardless of the sign of the number, to a multiple of 
significance (New in Excel 2010) 

http://www.excelfunctions.net/Excel-Abs-Function.html
http://www.excelfunctions.net/Excel-Sign-Function.html
http://www.excelfunctions.net/Excel-Gcd-Function.html
http://www.excelfunctions.net/Excel-Lcm-Function.html
http://www.excelfunctions.net/Excel-Sum-Function.html
http://www.excelfunctions.net/Excel-Product-Function.html
http://www.excelfunctions.net/Excel-Power-Function.html
http://www.excelfunctions.net/Excel-Sqrt-Function.html
http://www.excelfunctions.net/Excel-Quotient-Function.html
http://www.excelfunctions.net/Excel-Mod-Function.html
http://www.excelfunctions.net/Excel-Aggregate-Function.html
http://www.excelfunctions.net/Excel-Subtotal-Function.html
http://www.excelfunctions.net/excel-rounding-functions.html
http://www.excelfunctions.net/Excel-Ceiling-Function.html
http://www.excelfunctions.net/Excel-Ceiling-Precise-Function.html
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ISO.CEILING Rounds a number up, regardless of the sign of the number, to a multiple of 
significance. (New in Excel 2010) 

CEILING.MATH Rounds a number up to the nearest integer or to the nearest multiple of 
significance (New in Excel 2013) 

EVEN Rounds a number away from zero (i.e. rounds a positive number up and a 
negative number down), to the next even number 

FLOOR Rounds a number towards zero, (i.e. rounds a positive number down and a 
negative number up), to a multiple of significance 

FLOOR.PRECISE Rounds a number down, regardless of the sign of the number, to a multiple of 
significance (New in Excel 2010) 

FLOOR.MATH Rounds a number down, to the nearest integer or to the nearest multiple of 
significance (New in Excel 2013) 

INT Rounds a number down to the next integer 

MROUND Rounds a number up or down, to the nearest multiple of significance 

ODD Rounds a number away from zero (i.e. rounds a positive number up and a 
negative number down), to the next odd number 

ROUND Rounds a number up or down, to a given number of digits 

ROUNDDOWN Rounds a number towards zero, (i.e. rounds a positive number down and a 
negative number up), to a given number of digits 

ROUNDUP Rounds a number away from zero (i.e. rounds a positive number up and a 
negative number down), to a given number of digits 

TRUNC Truncates a number towards zero (i.e. rounds a positive number down and a 
negative number up), to the next integer. 

 

Matrix Functions 

MDETERM Returns the matrix determinant of a supplied array 

MINVERSE Returns the matrix inverse of a supplied array 

MMULT Returns the matrix product of two supplied arrays 

MUNIT Returns the unit matrix for a specified dimension (New in Excel 2013) 

 

Random Numbers 

RAND  Returns a random number between 0 and 1 

http://www.excelfunctions.net/Excel-Iso-Ceiling-Function.html
http://www.excelfunctions.net/excel-ceiling-math-function.html
http://www.excelfunctions.net/Excel-Even-Function.html
http://www.excelfunctions.net/Floor-Function.html
http://www.excelfunctions.net/Excel-Floor-Precise-Function.html
http://www.excelfunctions.net/excel-floor-math-function.html
http://www.excelfunctions.net/Int-Function.html
http://www.excelfunctions.net/Excel-Mround-Function.html
http://www.excelfunctions.net/Excel-Odd-Function.html
http://www.excelfunctions.net/Round-Function.html
http://www.excelfunctions.net/Excel-Rounddown-Function.html
http://www.excelfunctions.net/Excel-Roundup-Function.html
http://www.excelfunctions.net/Excel-Trunc-Function.html
http://www.excelfunctions.net/Excel-Mdeterm-Function.html
http://www.excelfunctions.net/Excel-Minverse-Function.html
http://www.excelfunctions.net/Excel-Mmult-Function.html
http://www.excelfunctions.net/excel-munit-function.html
http://www.excelfunctions.net/Excel-Rand-Function.html
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RANDBETWEEN Returns a random number between two given integers 

 

Conditional Sums 

SUMIF 
Adds the cells in a supplied range, that satisfy a given criteria 

SUMIFS 
Adds the cells in a supplied range, that satisfy multiple criteria (New in Excel 

2007) 

 

Advanced Mathematical Operations 

SUMPRODUCT 
Returns the sum of the products of corresponding values in two or more supplied 

arrays 

SUMSQ 
Returns the sum of the squares of a supplied list of numbers 

SUMX2MY2 
Returns the sum of the difference of squares of corresponding values in two 

supplied arrays 

SUMX2PY2 
Returns the sum of the sum of squares of corresponding values in two supplied 

arrays 

SUMXMY2 
Returns the sum of squares of differences of corresponding values in two 

supplied arrays 

SERIESSUM 
Returns the sum of a power series 

 

Trigonometry Functions 

PI 
Returns the constant value of pi 

SQRTPI 
Returns the square root of a supplied number multiplied by pi 

DEGREES  
Converts Radians to Degrees 

RADIANS  
Converts Degrees to Radians 

COS 
Returns the Cosine of a given angle 

ACOS 
Returns the Arccosine of a number 

COSH 
Returns the hyperbolic cosine of a number 

ACOSH 
Returns the inverse hyperbolic cosine of a number 

SEC 
Returns the secant of an angle (New in Excel 2013) 

SECH  
Returns the hyperbolic secant of an angle (New in Excel 2013) 

SIN 
Returns the Sine of a given angle 

ASIN 
Returns the Arcsine of a number 

http://www.excelfunctions.net/Excel-Randbetween-Function.html
http://www.excelfunctions.net/ExcelSumif.html
http://www.excelfunctions.net/Excel-Sumifs-Function.html
http://www.excelfunctions.net/Excel-Sumproduct-Function.html
http://www.excelfunctions.net/Excel-Sumsq-Function.html
http://www.excelfunctions.net/Excel-Sumx2my2-Function.html
http://www.excelfunctions.net/Excel-Sumx2py2-Function.html
http://www.excelfunctions.net/Excel-Sumxmy2-Function.html
http://www.excelfunctions.net/Excel-Seriessum-Function.html
http://www.excelfunctions.net/Excel-Pi-Function.html
http://www.excelfunctions.net/Excel-Sqrtpi-Function.html
http://www.excelfunctions.net/Excel-Degrees-Function.html
http://www.excelfunctions.net/Excel-Radians-Function.html
http://www.excelfunctions.net/Excel-Cos-Function.html
http://www.excelfunctions.net/Excel-Acos-Function.html
http://www.excelfunctions.net/Excel-Cosh-Function.html
http://www.excelfunctions.net/Excel-Acosh-Function.html
http://www.excelfunctions.net/excel-sec-function.html
http://www.excelfunctions.net/excel-sech-function.html
http://www.excelfunctions.net/Excel-Sin-Function.html
http://www.excelfunctions.net/Excel-Asin-Function.html
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SINH 
Returns the Hyperbolic Sine of a number 

ASINH 
Returns the Inverse Hyperbolic Sine of a number 

CSC 
Returns the cosecant of an angle (New in Excel 2013) 

CSCH  
Returns the hyperbolic cosecant of an angle (New in Excel 2013) 

TAN  
Returns the Tangent of a given angle 

ATAN  
Returns the Arctangent of a given number 

ATAN2  
Returns the Arctangent of a given pair of x and y coordinates 

TANH 
Returns the Hyperbolic Tangent of a given number 

ATANH  
Returns the Inverse Hyperbolic Tangent of a given number 

COT 
Returns the cotangent of an angle (New in Excel 2013) 

COTH 
Returns the hyperbolic cotangent of an angle (New in Excel 2013) 

ACOT 
Returns the arccotangent of a number (New in Excel 2013) 

ACOTH 
Returns the hyperbolic arccotangent of a number (New in Excel 2013) 

 

Exponents & Logarithms 

EXP 
Returns e raised to a given power 

LN 
Returns the natural logarithm of a given number 

LOG 
Returns the logarithm of a given number, to a specified base 

LOG10 
Returns the base 10 logarithm of a given number 

 

Factorials 

FACT 
Returns the Factorial of a given number 

FACTDOUBLE 
Returns the Double Factorial of a given number 

MULTINOMIAL 
Returns the Multinomial of a given set of numbers 

 

Miscellaneous 

BASE 
Converts a number into a text representation, with the supplied base (New in 

Excel 2013) 

DECIMAL 
Converts a text representation of a number in a specified base into a decimal 

number (New in Excel 2013) 

COMBIN 
Returns the number of combinations (without repititions) for a given number of 

objects 

COMBINA 
Returns the number of combinations (with repetitions) for a given number of 

items (New in Excel 2013) 

ARABIC 
Converts a Roman numeral to an Arabic numeral (New in Excel 2013) 

http://www.excelfunctions.net/Excel-Sinh-Function.html
http://www.excelfunctions.net/Excel-Asinh-Function.html
http://www.excelfunctions.net/excel-csc-function.html
http://www.excelfunctions.net/excel-csch-function.html
http://www.excelfunctions.net/Excel-Tan-Function.html
http://www.excelfunctions.net/Excel-Atan-Function.html
http://www.excelfunctions.net/Excel-Atan2-Function.html
http://www.excelfunctions.net/Excel-Tanh-Function.html
http://www.excelfunctions.net/Excel-Atanh-Function.html
http://www.excelfunctions.net/excel-cot-function.html
http://www.excelfunctions.net/excel-coth-function.html
http://www.excelfunctions.net/excel-acot-function.html
http://www.excelfunctions.net/excel-acoth-function.html
http://www.excelfunctions.net/Excel-Exp-Function.html
http://www.excelfunctions.net/Excel-Ln-Function.html
http://www.excelfunctions.net/Excel-Log-Function.html
http://www.excelfunctions.net/Excel-Log10-Function.html
http://www.excelfunctions.net/Excel-Fact-Function.html
http://www.excelfunctions.net/Excel-Factdouble-Function.html
http://www.excelfunctions.net/Excel-Multinomial-Function.html
http://www.excelfunctions.net/excel-base-function.html
http://www.excelfunctions.net/excel-decimal-function.html
http://www.excelfunctions.net/Excel-Combin-Function.html
http://www.excelfunctions.net/excel-combina-function.html
http://www.excelfunctions.net/excel-arabic-function.html
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ROMAN 
Returns a text string depicting the roman numeral for a given number 

 

Also, if we select the Logical, we get a list 
of possible logical functions as follows: 

Function Description 

AND 

function 

Returns TRUE if all of its arguments are TRUE 

FALSE 

function 

Returns the logical value FALSE 

IF function Specifies a logical test to perform 

IFERROR 

function 

Returns a value you specify if a formula evaluates to an error; otherwise, 

returns the result of the formula 

IFNA 

function  

 

Returns the value you specify if the expression resolves to #N/A, otherwise 

returns the result of the expression 

IFS function  

 

Checks whether one or more conditions are met and returns a value that 

corresponds to the first TRUE condition. 

NOT 

function 

Reverses the logic of its argument 

OR function  Returns TRUE if any argument is TRUE 

SWITCH 

function  

 

Evaluates an expression against a list of values and returns the result 

corresponding to the first matching value. If there is no match, an optional 

default value may be returned. 

TRUE 

function 

Returns the logical value TRUE 

XOR 

function  

 

Returns a logical exclusive OR of all arguments 

 

http://www.excelfunctions.net/Excel-Roman-Function.html
https://support.office.com/en-us/article/AND-function-5f19b2e8-e1df-4408-897a-ce285a19e9d9
https://support.office.com/en-us/article/AND-function-5f19b2e8-e1df-4408-897a-ce285a19e9d9
https://support.office.com/en-us/article/FALSE-function-2d58dfa5-9c03-4259-bf8f-f0ae14346904
https://support.office.com/en-us/article/FALSE-function-2d58dfa5-9c03-4259-bf8f-f0ae14346904
https://support.office.com/en-us/article/IF-function-69aed7c9-4e8a-4755-a9bc-aa8bbff73be2
https://support.office.com/en-us/article/IFERROR-function-c526fd07-caeb-47b8-8bb6-63f3e417f611
https://support.office.com/en-us/article/IFERROR-function-c526fd07-caeb-47b8-8bb6-63f3e417f611
https://support.office.com/en-us/article/IFNA-function-6626c961-a569-42fc-a49d-79b4951fd461
https://support.office.com/en-us/article/IFNA-function-6626c961-a569-42fc-a49d-79b4951fd461
https://support.office.com/en-us/article/IFS-function-36329a26-37b2-467c-972b-4a39bd951d45
https://support.office.com/en-us/article/NOT-function-9cfc6011-a054-40c7-a140-cd4ba2d87d77
https://support.office.com/en-us/article/NOT-function-9cfc6011-a054-40c7-a140-cd4ba2d87d77
https://support.office.com/en-us/article/OR-function-7d17ad14-8700-4281-b308-00b131e22af0
https://support.office.com/en-us/article/SWITCH-function-47ab33c0-28ce-4530-8a45-d532ec4aa25e
https://support.office.com/en-us/article/SWITCH-function-47ab33c0-28ce-4530-8a45-d532ec4aa25e
https://support.office.com/en-us/article/TRUE-function-7652c6e3-8987-48d0-97cd-ef223246b3fb
https://support.office.com/en-us/article/TRUE-function-7652c6e3-8987-48d0-97cd-ef223246b3fb
https://support.office.com/en-us/article/XOR-function-1548d4c2-5e47-4f77-9a92-0533bba14f37
https://support.office.com/en-us/article/XOR-function-1548d4c2-5e47-4f77-9a92-0533bba14f37
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Examples 
 

1- Math & Tri functions 

 

2-Statistical functions 

 

 

3-Logical statements 

 

No Function syntax Description Examples 

1 ABS ABS(number) Valuate the absolute value 

of a number 

Abs(6) = 6 

Abs(-5) = 5 

 

2 Combin Combin(n;x) Calculate the binomial 

coefficients 
n

x

 
 
 

  

 

Combin(5;3)=10 

 

 

3  

 

   

4 

 

    

5  

 

   

6 

 

    

No Function syntax Description Examples 

1 Average 

 

average(a1; a2; … 

an) 

Calculate the mean of a1, 

a2, ….an   

AVERAGE(1,8,9,2)=5 

2 

 

normdist 

 

Normdist(x; mean; 

standard deviation; 

cumulative) 

Calculate the cumulative 

probability function on 

normal distribution with 

given mean and standard 

derivation) 

Normdist( 1.96; 0; 1; True) = 0.9750 

3 Norminv 

 

   

     

No Function syntax Description Examples 

1 If  

 

If( logical test; 

statment1 if true; 

statement 2 if false) 

If statement; do statement 1 if 

true, do statement 2 if false 

Let x be a column of values 1, 2, 

3. write the following statement in 

the first cell of the column y 

if(x2<=1; 1; 2). The output of the 

column y will be 1,2,3.    

2 

 

    



 

2 
 

Some other examples on the statistical functions 

Examples  

1- Calculate the mean, median, variance, standard deviation and mode(s) for 

the following data 

               2, 3, 2, 2, 0, 2, 3, 6, 3, 2, 2, 4, 3, 1, 3, 3, 3, 2, 1, 5 

 

        To achieve this in excel put the data in a column (A1:A20) or raw  

           and use the following commands  

 

=AVERAGE(A1:A20) 

 

=MEDIAN(A1:A20) 

 

=STDEV.S(A1:A20) 

 

=STDEV.P(A1:A20) 

 

=VAR.P(A1:A20) 

 

=VAR.S(A1:A20) 

 

2- Frequency Table (Frequency-example) 

 

3- Probability distributions 

 

             If  (2,7)X N  ,    then   Calculate 



 

3 
 

( 1.5), (3), ( ) 0.25, ?P X f P X k k    

 

 

Some other examples on the mathematical functions  

 

Example  

Calculate exp(-1.5), Log(25) and   ln(25) 

 

Example on the logical functions 

 

Use if statement to print the status of the student ( 60, 60)Pass fail   

In creation exam using the following marks 

Marks 

70 

85 

83 

25 

80 

98 

80 

72 

42 

 

If(A1<60,”F”,”P”) 
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Some mathematical, statistical and logical functions in excel 

 

Some Examples on the Mathematical Function 

𝒆−𝟏.𝟓 =EXP(-1.5) 0.22313016 

𝐥𝐨𝐠(𝟐𝟓) =LOG(25) 1.397940009 

𝐥𝐧(𝟐𝟓) =LN(25) 3.218875825 

(
𝟏𝟎
𝟐
) =COMBIN(10,2) 

45 

√𝟐𝟓 =SQRT(25) 5 

|−𝟏𝟎| =ABS(-10) 10 

𝟑𝟐 =POWER(3,2) 

=3^2 9 

 

Some Examples on the Statistical Function 

Example 

Suppose we are interested in the number of children that a Saudi woman has and 

we take a sample of 20 women and obtain the following data on the number of 

children 

2, 3, 2, 2, 0, 2, 3, 6, 3, 2, 2, 4, 3, 1, 3, 3, 3, 2, 1, 5 

             -  Calculate the mean, median, variance, standard deviation, total,  

                 maximum, minimum and mode(s) 

 
 

             To achieve this in excel put the data in a column (A2:A21) or raw  and use 

              the following commands 

 

 

Total =SUM(A2:A21)  52 

Mean =AVERAGE(A2:A21)  2.6 

Median =MEDIAN(A2:A21)  2.5 

Max =MAX(A2:A21)  6 

Min =MIN (A2:A21)  0 

Standard =STDEV(A2:A21) New in Excel 2010  1.353358 
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deviation for 

sample 
=STDEV.S(A2:A21) 

Standard 

deviation for 

population 

= STDEV P(A2:A21) New in Excel 2010  

=STDEV.P(A2:A21) 

1.319091 

Variance for 

sample 

=VAR(A2:A21) New in Excel 2010  

=VAR.S(A2:A21) 1.831579 

Variance for 

population 

=VARP (A2:A21) New in Excel 2010  

=VAR.S(A2:A21) 1.74 

 

- Frequency Table  

N.children  Frequency 

0 =COUNTIF(A2:A21,”0”) 1 

1 =COUNTIF(A2:A21,”1”) 2 

2 =COUNTIF(A2:A21,”2”) 7 

3 =COUNTIF(A2:A21,”3”) 7 

4 =COUNTIF(A2:A21,”4”) 1 

5 =COUNTIF(A2:A21,”5”) 1 

6 =COUNTIF(A2:A21,”6”) 1 

 

 

-  Probability distributions  

If 𝑋~𝑁(2,7), then Calculate 

𝑃(𝑋 < 1.5) =NORMDIST(1.5,2,7,TRUE) 0.471528 

𝑃(𝑋 < 𝑘) = 0.25, 𝑘? =NORMINV(0.25,2,7) -2.72143 

 

 

Example on the Logical Functions 

Use if statement to print the status of the student (𝑃𝑎𝑠𝑠 ≥ 60, 𝐹𝑎𝑖𝑙 < 60). In 

creation exam using the following marks 

 A   

1 Marks Function Grade 

2 70 =IF(A2<60,”Fail”,”Pass”) Pass 
3 85 =IF(A3<60,”Fail”,”Pass”) Pass 
4 83 =IF(A4<60,”Fail”,”Pass”) Pass 
5 25 =IF(A5<60,”Fail”,”Pass”) Fail 
6 80 =IF(A6<60,”Fail”,”Pass”) Pass 
7 98 =IF(A7<60,”Fail”,”Pass”) Pass 
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8 80 =IF(A8<60,”Fail”,”Pass”) Pass 
9 72 =IF(A9<60,”Fail”,”Pass”) Pass 
10 42 =IF(A10<60,”Fail”,”Pass”) Fail 
11 32 =IF(A11<60,”Fail”,”Pass”) Fail 
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Descriptive statistics using excel 

 

 - Data Analysis 

 The Analysis ToolPak is an Excel add-in program that provides data analysis tools 

for financial, statistical and engineering data analysis. 

To load the Analysis ToolPak add-in, execute the following steps. 

 

  

1. Click on Excel Options.  

 

 

 

 2. Under Add-ins, select Analysis ToolPak and click on the Go button. 
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3. Check Analysis ToolPak and click on OK. 
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4. On the Data tab, you can now click on Data Analysis. 

 

The following dialog box below appears. 
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Examples on Data analysis 

Descriptive Statistics  

You can use the Analysis Toolpak add-in to generate descriptive statistics. For 

example, you may have the scores of 14 participants for a test.  

 
 

To generate descriptive statistics for these scores, execute the following steps.  

1. On the Data tab, click Data Analysis. 

 

 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak 

add-in.  

 

 

2. Select Descriptive Statistics and click OK. 
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3. Select the range A2:A15 as the Input Range.  

4. Select cell C1 as the Output Range.  

5. Make sure Summary statistics is checked. 

 
6. Click OK.  

Result: 
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Statistical tests using excel 

1- Analysis of variance (ANOVA)  

-  One Way ANOVA 

𝛼 = 0.05. 

Hypotheses testing:  

𝐻0: 𝜇1 = 𝜇2 = ⋯ = 𝜇𝑘 

𝐻1: at least one of the means is different. 

Test statistic: 

𝐹 =
𝑀𝑆𝐴

𝑀𝑆𝐸
 

Critical region: 

Reject 𝐻0 if 𝐹 > 𝐹1−𝛼,(𝑣1,𝑣2) 

Or 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 𝛼 

Decision: 

 

This example teaches you how to perform a single factor ANOVA (analysis of 

variance) in Excel. A single factor or one-way ANOVA is used to test the null 

hypothesis that the means of several populations are all equal.  

Below you can find the salaries of people who have a degree in economics, 

medicine or history. 
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To perform a single factor ANOVA, execute the following steps.  

1. On the Data tab, click Data Analysis.  

 
Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak 

add-in.  

2. Select Anova: Single Factor and click OK. 

 
3. Click in the Input Range box and select the range A2:C10.  

4. Click in the Output Range box and select cell E1. 
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5. Click OK.  

Result: 
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𝛼 = 0.05. 

Hypotheses testing:  

𝐻0: 𝜇1 = 𝜇2 = 𝜇3 

𝐻1: at least one of the means is different. 

Test statistic: 

𝐹 =
𝑀𝑆𝐴

𝑀𝑆𝐸
= 15.19623 

Critical region: 

𝐹1−𝛼,(𝑣1,𝑣2) = 𝐹 𝑐𝑟𝑖𝑡 = 3.443357 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 = 0.00007163 

 

Reject 𝐻0 if 𝐹 > 3.443 

Or 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 0.05 

Decision: 

Therefore, we reject the null hypothesis. The means of the three populations are 

not all equal. At least one of the means is different. However, the ANOVA does 

not tell you where the difference lies. You need a t-Test to test each pair of means. 
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- Two-Factor Analysis of Variance 

𝛼 = 0.05. 

The three hypotheses to be tested are as follows: 

Hypotheses testing:  

1. 𝐻0: 𝑎1 = 𝑎2 = ⋯ = 𝑎𝑎 = 0 

    𝐻1: At least one of the 𝑎𝑖  is not equal to zero. 

2. 𝐻0: 𝛽1 = 𝛽2 = ⋯ = 𝛽𝑏 = 0 

    𝐻1: At least one of the 𝛽𝑗 is not equal to zero. 

3. 𝐻0: (𝑎𝛽)11 = (𝑎𝛽)12 = ⋯ = (𝑎𝛽)𝑎𝑏 = 0 

    𝐻1: At least one of the (𝑎𝛽)𝑖𝑗 is not equal to zero. 

Critical region: 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 𝛼 

Decision: 

 

- ANOVA two ways with Replication 

In the following example, the cost of three swimming programs in two regions in 

the East and the West 

 SQ RQ TQ 

East 19 8 21 

18 10 31 

25 10 26 

20 18 28 

17 7 14 

21 16 24 

West 15 23 31 

28 32 31 

17 26 26 

14 16 20 

17 27 14 

13 18 9 
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1. On the Data tab, click Data Analysis.  

 
2. Select Anova: Two-Factor With Replication and click OK. 

 
3. Click in the Input Range box and select the range A1:D13.  

4. Click in the Output Range box and select cell E2. 

 

5. Click OK.  

Result: 
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𝛼 = 0.05. 

1) Hypotheses testing:  

𝐻0: 𝑎𝐸𝑎𝑠𝑡 = 𝑎𝑊𝑒𝑠𝑡 = 0 

𝐻1: at least one of the means is different. 

Test statistic: 

𝐹 = 1.4416 

Critical region: 

𝐹1−𝛼,(𝑣1,𝑣2) = 𝐹 𝑐𝑟𝑖𝑡 = 4.1708 
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𝑝 − 𝑣𝑎𝑙𝑢𝑒 = 0.2392 

Reject 𝐻0 if 𝐹 > 4.1708     Or    𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 0.05 

Decision: 

Therefore, we not reject the null hypothesis. There are no difference in the means 

of the cost between the two regions in the east and the west. 

2) Hypotheses testing:  

𝐻0: 𝛽𝑆𝑄 = 𝛽𝑅𝑄 = 𝛽𝑇𝑄 = 0 

𝐻1: at least one of the means is different. 

Test statistic: 

𝐹 = 2.871 

Critical region: 

𝐹1−𝛼,(𝑣1,𝑣2) = 𝐹 𝑐𝑟𝑖𝑡 = 3.3158 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 = 0.0722 

Reject 𝐻0 if 𝐹 > 3.3158      Or    𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 0.05 

Decision: 

Therefore, we not reject the null hypothesis. There was no significant difference 

between the mean cost of the three programs. 

3) Hypotheses testing:  

𝐻0: 𝑎𝛽𝐸𝑎𝑠𝑡,𝑆𝑄 = 𝑎𝛽𝐸𝑎𝑠𝑡,𝑅𝑄 = 𝑎𝛽𝐸𝑎𝑠𝑡,𝑇𝑄 = 𝑎𝛽𝑊𝑒𝑠𝑡,𝑆𝑄 = 𝑎𝛽𝑊𝑒𝑠𝑡,𝑅𝑄 = 𝑎𝛽𝑊𝑒𝑠𝑡,𝑇𝑄 = 0 

𝐻1: at least one of the means is different. 
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Test statistic: 

𝐹 = 6.4163 

Critical region: 

𝐹1−𝛼,(𝑣1,𝑣2) = 𝐹 𝑐𝑟𝑖𝑡 = 3.3158 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 = 0.0047 

Reject 𝐻0 if 𝐹 > 3.3158      Or    𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 0.05 

Decision: 

Therefore, we reject the null hypothesis. There is interaction between the two 

factors (region, type of program). 
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- ANOVA two ways without Replication 

In the following example, the price of three swimming programs in six areas 

 SQ RQ TQ 

1 19 8 21 

2 18 10 31 

3 25 10 26 

4 20 18 28 

5 17 7 14 

6 21 16 24 

 

𝛼 = 0.05. 

The two hypotheses to be tested are as follows: 

Hypotheses testing:  

1. 𝐻0: 𝑎1 = 𝑎2 = ⋯ = 𝑎𝑎 = 0 

    𝐻1: At least one of the 𝑎𝑖  is not equal to zero. 

2. 𝐻0: 𝛽1 = 𝛽2 = ⋯ = 𝛽𝑏 = 0 

    𝐻1: At least one of the 𝛽𝑗 is not equal to zero. 

Critical region: 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 𝛼 

Decision: 

1. On the Data tab, click Data Analysis.  

 
2. Select Anova: Two-Factor With Replication and click OK. 
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3. Click in the Input Range box and select the range B2:D7.  

4. Click in the Output Range box and select cell E3. 

 

5. Click OK.  

Result: 
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𝛼 = 0.05. 

1) Hypotheses testing:  

𝐻0: 𝑎1 = 𝑎2 = ⋯ = 𝑎6 = 0 

𝐻1: at least one of the means is different. 

Test statistic: 

𝐹 = 2.6805 

Critical region: 

𝐹1−𝛼,(𝑣1,𝑣2) = 𝐹 𝑐𝑟𝑖𝑡 = 3.3258 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 = 0.0866 
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Reject 𝐻0 if 𝐹 > 3.3258     Or    𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 0.05 

Decision: 

Therefore, we not reject the null hypothesis. There are no difference in the means 

of the cost between the six areas. 

2) Hypotheses testing:  

𝐻0: 𝛽𝑆𝑄 = 𝛽𝑅𝑄 = 𝛽𝑇𝑄 = 0 

𝐻1: at least one of the means is different. 

Test statistic: 

𝐹 = 18.022 

Critical region: 

𝐹1−𝛼,(𝑣1,𝑣2) = 𝐹 𝑐𝑟𝑖𝑡 = 4.1028 

𝑝 − 𝑣𝑎𝑙𝑢𝑒 = 0.0004 

Reject 𝐻0 if 𝐹 > 4.1028      Or    𝑝 − 𝑣𝑎𝑙𝑢𝑒 ≤ 0.05 

Decision: 

Therefore, we reject the null hypothesis. There is a significant difference between 

the mean prices of the three programs. 
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3- F-Test 

 This example teaches you how to perform an F-Test in Excel. The F-Test is used to 

test the null hypothesis that the variances of two populations are equal. 

Below you can find the study hours of 6 female students and 5 male students. 

 

H0: σ12 =σ22 

 

H1: σ12 ≠ σ22 

 

 

To perform an F-Test, execute the following steps. 

1. On the Data tab, click Data Analysis. 

 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak 

add-in. 

2. Select F-Test Two-Sample for Variances and click OK. 

http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html
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3. Click in the Variable 1 Range box and select the range A2:A7. 

4. Click in the Variable 2 Range box and select the range B2:B6. 

5. Click in the Output Range box and select cell E1. 

 

6. Click OK. 

Result: 
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Important: be sure that the variance of Variable 1 is higher than the variance of 

Variable 2. This is the case, 160 > 21.7. If not, swap your data. As a result, Excel 

calculates the correct F value, which is the ratio of Variance 1 to Variance 2 (F = 

160 / 21.7 = 7.373). 

Conclusion: if F > F Critical one-tail, we reject the null hypothesis. This is the case, 

7.373 > 6.256. Therefore, we reject the null hypothesis. The variances of the two 

populations are unequal. 

 

 

 

4- t-Test 

 This example teaches you how to perform a t-Test in Excel. The t-Test is used to 

test the null hypothesis that the means of two populations are equal. 

Below you can find the study hours of 6 female students and 5 male students. 

H0: μ1 -μ2 =0 

 

H1: μ1 - μ2 ≠ 0 

 

To perform a t-Test, execute the following steps. 

1. First, perform an F-Test to determine if the variances of the two populations are 

equal. This is not the case. 

2. On the Data tab, click Data Analysis. 

http://www.excel-easy.com/examples/f-test.html


4 
 

 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak 

add-in. 

3. Select t-Test: Two-Sample Assuming Unequal Variances and click OK. 

 

4. Click in the Variable 1 Range box and select the range A2:A7. 

5. Click in the Variable 2 Range box and select the range B2:B6. 

6. Click in the Hypothesized Mean Difference box and type 0 (H0: μ1 - μ2 = 0). 

7. Click in the Output Range box and select cell E1. 

 

8. Click OK. 

http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html
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Result: 

 

 

Conclusion:  

We do a two-tail test (inequality). lf t Stat < -t Critical two-tail or t Stat > t Critical 

two-tail, we reject the null hypothesis. This is not the case, -2.365 < 1.473 < 2.365. 

Therefore, we do not reject the null hypothesis. The observed difference between the 

sample means (33 - 24.8) is not convincing enough to say that the average number 

of study hours between female and male students differ significantly. 
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5- Paired Sample t Test 

In paired sample hypothesis testing, a sample from the population is chosen and two 

measurements for each element in the sample are taken. Each set of measurements 

is considered a sample. Unlike the hypothesis testing studied so far, the two samples 

are not independent of one another. Paired samples are also called matched 

samples or repeated measures. 

Example: 

 A clinic provides a program to help their clients lose weight and asks a consumer 

agency to investigate the effectiveness of the program. The agency takes a sample 

of 15 people, weighing each person in the sample before the program begins and 3 

months later to produce the table below. 

 

Determine whether the program is effective? 

https://i0.wp.com/www.real-statistics.com/wp-content/uploads/2012/11/paired-sample-data-excel.jpg
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Solution 

Let x = the difference in weight 3 months after the program starts. The null 

hypothesis is: 

H0: μ = 0; i.e. any differences in weight is due to chance 

We use the Excel’s t-Test: Paired Two Sample for Means data analysis tool or the T 

Test. The output from the Excel data analysis tool is shown below: 

 

Note that the mean differences are the same, but the standard deviation for the paired 

sample case is lower, which results in a higher t-stat and a lower p-value. This is 

generally true. 

Observation: Since the two sample paired data case is equivalent to the one sample 

case. 

 

 

 

 

https://i2.wp.com/www.real-statistics.com/wp-content/uploads/2013/02/image760.png
https://i2.wp.com/www.real-statistics.com/wp-content/uploads/2013/02/image760.png
https://i0.wp.com/www.real-statistics.com/wp-content/uploads/2012/11/paired-samples-excel-tool.png
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6- Correlation 

  

The correlation coefficient (a value between -1 and +1) tells you how strongly two 

variables are related to each other. We can use the CORREL function or 

the Analysis Toolpak add-in in Excel to find the correlation coefficient between two 

variables. 

- A correlation coefficient of +1 indicates a perfect positive correlation. As variable 

X increases, variable Y increases. As variable X decreases, variable Y decreases. 

 

- A correlation coefficient of -1 indicates a perfect negative correlation. As variable 

X increases, variable Z decreases. As variable X decreases, variable Z increases. 

kholo
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- A correlation coefficient near 0 indicates no correlation. 

To use the Analysis Toolpak add-in in Excel to quickly generate correlation 

coefficients between multiple variables, execute the following steps. 

1. On the Data tab, click Data Analysis. 

 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak 

add-in. 

2. Select Correlation and click OK. 

http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html
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3. For example, select the range A1:C6 as the Input Range. 

 

4. Check Labels in first row. 

5. Select cell A9 as the Output Range. 

6. Click OK. 
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Result. 

 

Conclusion: variables A and C are positively correlated (0.91). Variables A and B 

are not correlated (0.19). Variables B and C are also not correlated (0.11) . You can 

verify these conclusions by looking at the graph. 
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7-Regression  

This example teaches you how to perform a regression analysis in Excel and how to 

interpret the Summary Output. 

In this study a random sample of service call records for a computer repair operation 

were examined and the length of each call (in minutes) and the number of components 

repaired or replaced were recorded. The data is given below. 

  

Minutes Units 

23 1 

29 2 

49 3 

64 4 

74 4 

87 5 

96 6 

97 6 

109 7 

119 8 

149 9 

145 9 

154 10 

166 10 

 

Below you can find our data. The big question is:  

is there a relation between Minutes (Output) and Units (Input). In other words: can 

we predict Minutes if we know the unites? 

 

1. On the Data tab, click Data Analysis. 



6 
 

 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak 

add-in. 

2. Select Regression and click OK. 

 

3. Select the Y Range (A2:A15). This is the predictor variable (also called dependent 

variable). 

4. Select the X Range(B2:B15). These are the explanatory variables (also called 

independent variables). These columns must be adjacent to each other. 

5. Check Labels. 

6. Select an Output Range. 

8. Click OK. 

 

 

http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html
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Excel produces the following Summary Output (rounded to 3 decimal places). 

 

Results 

The regression line is: y = Minutes=4.162+15.509*Units.  In other words, for 

increasing the units by one, the Time Minutes increases by 15.509, while there is 

4.162 minutes does not depend on the unites.   
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Part 3 

 

Some Statistical Charts in Excel 

 

Excel provides fairly extensive capabilities for creating graphs, what Excel 

calls charts. You can access Excel’s charting capabilities by selecting Insert > 

Charts. We will describe how to create bar and line charts here. Elsewhere on the 

website we describe how to create scatter charts. Other types of charts are created in 

a similar manner. Once a chart is created three new ribbons are accessible, 

namely Design, Layout and Format. These are used to refine the chart created. 

 

1- Bar charts 

To create a bar chart, execute the following steps: 

1. Enter the data that you are charting into a worksheet. 

2. Highlight the data range and select Insert > Charts|Column. A list of bar chart 

types is displayed. As usual you can place the mouse pointer over the picture of 

any chart type to get a brief description of that chart type. E.g. the first type is a 

2-dimensional side-by-side bar chart while second choice is a 2-dimensional 

stacked bar chart. 

3. Use the Design, Layout and Format ribbons to refine the chart. At any time, you 

can click on the chart to get access to these ribbons. 

We now demonstrate how to create a bar chart via the following example. 

 

 

http://www.real-statistics.com/correlation/scatter-diagrams/
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Example  

 The following data represents the sales in millions of Euros in for a certain product 

has three brands A, B and C 

City Brand A Brand B Brand C 

London 13.5 12.3 15 

Paris 13.8 8.1 5.5 

Rome 17.3 4.5 6.9 

Madrid 14.8 6.8 2.7 

Vienna 7.2 4.2 1.6 

Berlin 29.5 21.4 11.5 

 

The first step is to enter the data into the worksheet. We next highlight the range the 

data including the row and column headings, and select Insert > Charts|Column. 

 

 

 

The resulting chart, although initially the chart does not contain a chart title or axes 

titles. To add a chart title click on the chart, select Layout > Labels|Chart Title and 

then choose Above Chart and enter the title sales. The title of the horizontal axis can 

be added in a similar manner by selecting Layout > Labels|Axis Titles > Primary 

Horizontal Axis Title > Title Below Axis and entering the word City. Finally, the 
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title of the vertical axis is added by selecting Layout > Labels|Axis Titles > Primary 

Vertical Axis Title > Rotated Title. 

 

2-Pie charts 

 

For the previous example draw the pie chart for brand A 

 

 

 

Also, 

 

 

 

 

Brand A

London Paris Rome Madrid Vienna Berlin
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3-scatter plot 

 

 

4-Boxplot 
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4-Histogram 

 

We explain how to create the Histogram in Excel through the following example 

given in the file Histogram.xls. This example teaches you how to create 

a histogram in Excel. 

 

1. First, enter the bin numbers (upper levels) in the range C3:C7. 

 

2. On the Data tab, click Data Analysis. 
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Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak 

add-in. 

3. Select Histogram and click OK. 

 

4. Select the range A2:A19. 

5. Click in the Bin Range box and select the range C3:C7. 

6. Click the Output Range option button, click in the Output Range box and select 

cell F3. 

7. Check Chart Output. 

 

8. Click OK. 

http://www.excel-easy.com/data-analysis/analysis-toolpak.html
http://www.excel-easy.com/data-analysis/analysis-toolpak.html
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9. Click the legend on the right side and press Delete. 

10. Properly label your bins.  

11. To remove the space between the bars, right click a bar, select Format Data Series 

and change the Gap Width to 0%. Select Border Color to add a border. 

Result: 

 

 

 



 

Working With Matrices In Excel 

 

To work with matrices in excel, especially with the multiplications and 

inverse, you have to  follow the following steps 

 

1- Select suitable (m x n) block anywhere else in your spreadsheet to 

receive the expected results on them.  

 

2- Press the “F2” key. • Press the “=” sign 

 

3- Type the matrix function with its arguments.  

 

4- Hold down the keys “Ctrl” and “Shift” at the same time and press 

the “Enter” key while holding down the other two. 

 

 

Example: 

 

Find the inverse of  

 

𝐴 = (
2 −2 1
3 1 −1
1 −3 2

) 

 

 

 

 

 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Example 

 

Example: 

 

Find the A.C, such that    

 

𝐴 = (
2 −2 1
3 1 −1
1 −3 2

) ,     𝐶 = (
1 1
2 1
2 3

) 

 

 

Solution 

 
 

 



 

 
 

 

 

 

 

 

 

 



Matrix determinant 
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Generation Random samples 

 

 Generation from uniform distribution between 0 and 1 

 

To generate a random sample between 0 and 1 follow the steps below 

 

1- Highlight number the cells (in column A, for example) equal the sample 

size. 

 

2- Type "=RAND()" without the quotes into the Formula bar, and then press 

"Ctrl-Enter" to assign random numbers to your selection. 

 

 

 Random between two numbers  

 

                     =RANDBETWEEN(a,b) 

 

 Random sample 
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 Random number generation from distributions 
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 Rank and percentile  

 

 

 

 

 

 

 


